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Warranty
The material contained in this 
document is provided “as is,” and is 
subject to being changed, without 
notice, in future editions. Further, to 
the maximum extent permitted by 
applicable law, Agilent disclaims all 
warranties, either express or 
implied, with regard to this manual 
and any information contained 
herein, including but not limited to 
the implied warranties of 
merchantability and fitness for a 
particular purpose. Agilent shall not 
be liable for errors or for incidental 
or consequential damages in 
connection with the furnishing, use, 
or performance of this document or 
of any information contained herein. 
Should Agilent and the user have a 
separate written agreement with 
warranty terms covering the material 
in this document that conflict with 
these terms, the warranty terms in 
the separate agreement shall 
control.

Technology Licenses
The hardware and/or software 
described in this document are 
furnished under a license and may 
be used or copied only in accordance 
with the terms of such license.

Restricted Rights Legend
If software is for use in the 
performance of a U.S. Government 
prime contract or subcontract, 
Software is delivered and licensed 
as “Commercial computer software” 

as defined in DFAR 252.227-7014 
(June 1995), or as a “commercial 
item” as defined in FAR 2.101(a) or 
as “Restricted computer software” 
as defined in FAR 52.227-19 (June 
1987) or any equivalent agency 
regulation or contract clause. Use, 
duplication or disclosure of Software 
is subject to Agilent Technologies’ 
standard commercial license terms, 
and non-DOD Departments and 
Agencies of the U.S. Government 
will receive no greater than 
Restricted Rights as defined in FAR 
52.227-19(c)(1-2) (June 1987). U.S. 
Government users will receive no 
greater than Limited Rights as 
defined in FAR 52.227-14 (June 
1987) or DFAR 252.227-7015 (b)(2) 
(November 1995), as applicable in 
any technical data.

Safety Notices
CAUTION
A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in damage to the 
product or loss of important data. Do 
not proceed beyond a CAUTION 
notice until the indicated conditions 
are fully understood and met. 

WARNING
A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or the 
like that, if not correctly performed 
or adhered to, could result in 
personal injury or death. Do not 
proceed beyond a WARNING notice 
until the indicated conditions are 
fully understood and met.
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Warranty
This Agilent technologies instrument product is warranted against defects in material and workmanship for a period of 
one year from the date of shipment. During the warranty period, Agilent Technologies will, at its option, either repair or 
replace products that prove to be defective.

For warranty service or repair, this product must be returned to a service facility designated by Agilent Technologies. 
Buyer shall prepay shipping charges to Agilent Technologies, and Agilent Technologies shall pay shipping charges to 
return the product to Buyer. For products returned to Agilent Technologies from another country, Buyer shall pay all 
shipping charges, duties, and taxes.

Where to Find the Latest Information
Documentation is updated periodically. For the latest information about these products, including instrument software 
upgrades, application information, and product information, see the following URLs:

http://www.agilent.com/find/pxa

http://www.agilent.com/find/mxa

http://www.agilent.com/find/exa

http://www.agilent.com/find/cxa

To receive the latest updates by email, subscribe to Agilent Email Updates:

http://www.agilent.com/find/emailupdates

Information on preventing instrument damage can be found at:

http://www.agilent.com/find/tips

Is your product software up-to-date?
Periodically, Agilent releases software updates to fix known defects and incorporate product enhancements. To search 
for software updates for your product, go to the Agilent Technical Support website at:

http://www.agilent.com/find/techsupport

http://www.agilent.com/find/mxa
http://www.agilent.com/find/exa
http://www.agilent.com/find/tips
http://www.agilent.com/find/emailupdates
http://www.agilent.com/find/pxa
http://www.agilent.com/find/cxa
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2 Contacting Agilent Sales and 
Service Offices

Assistance with test and measurement needs, and information to help you find a local Agilent office, is 
available via the internet at, http://www.agilent.com/find/assist. If you do not have internet access, please 
contact your designated Agilent representative.

NOTE In any correspondence or telephone conversation, refer to the instrument by its model 
number and full serial number. With this information, the Agilent representative can 
determine whether your unit is still within its warranty period.

http://www.agilent.com/find/assist
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3 Products Covered by this 
Document

This document describes instrument memory types and security features. It provides a statement regarding 
the volatility of all memory types, and specifies the steps required to declassify an instrument through 
memory clearing, sanitization, or removal. 

For additional information, go to:

http://www.agilent.com/find/security

IMPORTANT Be sure that all information stored by the user in the instrument that needs to be saved 
is properly backed up before attempting to clear any of the instrument memory. Agilent 
Technologies cannot be held responsible for any lost files or data resulting from the 
clearing of memory. 

Be sure to read this document entirely before proceeding with any file deletion or 
memory clearing.

Product Family Name Product Names Model Numbers

X-Series Signal Analyzers PXA Signal Analyzer N9030A-503, -508, -513, -526

MXA Signal Analyzer N9020A-503, -508, -513, -526

EXA Signal Analyzer N9010A-503, -507, -513, -526

CXA Signal Analyzer N9000A-503, -507
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X-Series Processor and Disk Drive Configurations
This document describes alternative Processor and Disk Drive Configurations for X-Series analyzers. Due to 
continuous improvement of the X Series Analyzer range, configurations may vary according to such factors 
as: manufacturing date, product name, and installed options. Processor and disk drive configurations are 
considered separately, due to the large number of possible combinations.

Processor Assembly Configuration
There are three possible processor assembly configurations: a single-core microprocessor with 
non-removable (fixed) disk drive, a single-core microprocessor with removable disk drive, or a dual-core 
processor with removable disk drive. The relationship between processor assembly type and product name is 
detailed in Table 3-1 below. (For details of how to determine installed options, see “Determining Installed 
Options” on page 15)

Disk Drive Configuration
There are several possible disk drive configurations, as listed below in Table 3-2. The actual configuration 
depends on the instrument’s Product Name and installed options (Option SSD, Option PC2, Option PC3). For 
details of how to determine installed options, see “Determining Installed Options” on page 15.

Table 3-1 Processor Assembly & Product Name

Type Configuration Product Names & Installed Options

1 Single-Core, Fixed Disk The disk is referred to as "fixed", because it can only be removed 
by removing and opening the instrument’s processor assembly. 
This configuration is standard for:

a. MXA instruments without Option PC2,
b. EXA instruments without Option PC2 or PC3,
c. CXA instruments without Option PC3.

2 Single-Core, Removable 
Disk

The disk may be removed from the instrument’s rear panel, without 
removing or opening the processor assembly.
This configuration is standard for:

a. EXA instruments with Option PC3,
b. CXA instruments with Option PC3.

3 Dual-Core, Removable 
Disk

The disk may be removed from the instrument’s rear panel, without 
removing or opening the processor assembly.
The Dual-Core processor unit is standard for:

a. all PXA instruments, 
b. MXA instruments with Option PC2,
c. EXA instruments with Option PC2.
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For details of the capacities of each of the drive types listed below, see “Non-Volatile Memory” on page 20.

Option SSD

You can obtain a Removable Solid-State disk drive for your instrument, either as an upgrade to replace a 
Removable Magnetic disk drive, or as an additional solid-state drive, by ordering Option SSD. You can order 
Option SSD either at the time that you purchase the instrument, or at any later time. 

If your instrument’s current processor assembly configuration is Single-Core, Fixed Disk, in order to be able to 
use the removable disk you will need to upgrade the instrument to a Dual-Core, Removable Disk or 
Single-Core, Removable Disk processor assembly, by ordering Option PC2 or PC3 respectively.

Note that Removable Solid-State disk units exist in two capacities. Earlier disks had a total capacity of 32 GB, 
while newer units have a total capacity of 80 GB.

Table 3-2 Disk Drive Configurations

Type Configuration Product Names & Installed Options

Fixed 
Magnetic

Fixed Magnetic Drive This configuration applies to:

a. MXA instruments without Option PC2,
b. EXA instruments without Option PC2 or PC3,
c. CXA instruments without Option PC3.

Removable 
Magnetic

Standard Removable 
Magnetic Drive

This configuration applies to:

a. PXA instruments without Option SSD,
b. MXA instruments with Option PC2, but without Option 

SSD. 
c. EXA instruments with Option PC2 or PC3, but without 

Option SSD.

Removable 
Solid-State

Removable Solid-State 
Drive
(Flash drive)

This configuration applies to all instruments with Option 
SSD.
Originally an option, a solid-state disk drive cartridge is now 
supplied by default with X-Series Analyzers.
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Determining Instrument Configuration based on Product Name
Use the following procedures to determine the processor assembly and disk drive configurations of your 
instrument, starting from its Product Name.

Processor Assembly Configuration
The following procedure allows you to determine whether your instrument has a Single-Core, Fixed Disk, 
Single-Core, Removable Disk or Dual-Core, Removable Disk processor assembly.

Step Procedure

1 What is the Product Name of your instrument?

PXA: Go to Step 8.
MXA: Go to Step 2.
EXA: Go to Step 3.
CXA: Go to Step 5.

2 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel 
Configurations” on page 14. Does it resemble or Figure 3-1 (Fixed Disk) or Figure 3-2 (Removable 
Disk)?
Fixed Disk: Go to Step 6.
Removable Disk: Go to Step 8.

3 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel 
Configurations” on page 14. Does it resemble or Figure 3-1 (Fixed Disk) or Figure 3-2 (Removable 
Disk)?
Fixed Disk: Go to Step 6.
Removable Disk: Go to Step 4.

4 Are Options PC2 or PC3 installed? 
(To determine whether Options PC2 or PC3 are installed, see “Determining Installed Options” on 
page 15 below.)
PC2 installed: Go to Step 8.
PC3 installed: Go to Step 7.

5 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel 
Configurations” on page 14. Does it resemble or Figure 3-1 (Fixed Disk) or Figure 3-2 (Removable 
Disk)?
Fixed Disk: Go to Step 6.
Removable Disk: Go to Step 7.

6 Your instrument has a Single-Core, Fixed Disk processor assembly.

7 Your instrument has a Single-Core, Removable Disk processor assembly.
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Disk Drive Configuration
The following procedure allows you to determine your instrument’s disk drive configuration

8 Your instrument has a Dual-Core, Removable Disk processor assembly.

Step Procedure

1 What is the Product Name of your instrument?

PXA: Go to Step 5.
MXA: Go to Step 3.
EXA: Go to Step 3.
CXA: Go to Step 2.

2 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel 
Configurations” on page 14. Does it resemble or Figure 3-1 (Fixed Disk) or Figure 3-2 (Removable 
Disk)?
Fixed Disk: Go to Step 4.
Removable Disk: Go to Step 6.

3 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel 
Configurations” on page 14. Does it resemble or Figure 3-1 (Fixed Disk) or Figure 3-2 (Removable 
Disk)?
Fixed Disk: Go to Step 4.
Removable Disk: Go to Step 5.

4 Your instrument has a 40 GB Fixed Magnetic disk drive.

5 Check the instrument’s installed options (see “Determining Installed Options” on page 15).
If the list includes "N90X0A-IDE", your instrument has a 160 GB Removable Magnetic disk drive.
If the list includes "N90X0A-SSD", your instrument has a 32 GB or 80 GB Removable Solid-State 
disk drive.

6 Your instrument has a 32 GB or 80 GB Removable Solid-State disk drive.

Step Procedure



14 

Products Covered by this Document
Determining Instrument Configuration based on Product Name

Rear Panel Configurations

Figure 3-1 Rear Panel of Instrument with Fixed Magnetic Disk

Figure 3-2 Rear Panel of Instrument with Removable Magnetic or Removable Solid-State Disk
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Determining Installed Options
Use the following procedure to determine whether your instrument has a magnetic or solid-state disk drive, 
and whether Options PC2 (Dual-Core Processor), or PC3 (Single-Core High-Performance Processor) are 
installed.

1. Using the instrument front panel and softkey menus, press System > Show > System.

2. The "Show System" display appears. Look for start of the "Option" listing, a few lines below the top of 
the table, as shown in Figure 3-3 below.

Figure 3-3 Show System Display: Option Listing

3. If the Option list includes "N90X0A-SSD" (where "X" is a digit between 0 and 3, according to the Model 
Number), then a Removable Solid-State disk drive is installed (either because the instrument was 
supplied with this drive, or because Option SSD has been installed).

If your instrument has a Fixed Magnetic or Removable Magnetic disk drive, then "N90X0A-IDE" is listed, 
as shown in Figure 3-3 above.

4. If the Option list includes "N90X0A-PC2" (where "X" is a digit between 1 and 3, according to the Model 
Number), then Option PC2 is installed.

5. If the Option list includes "N90X0A-PC3" (where "X" is a digit between 0 and 1, according to the Model 
Number), then Option PC3 is installed.

6. To dismiss the "Show System" display, press any other front-panel or menu key.
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4 Security Terms and 
Definitions

Term Definition

Clearing As defined in Section 8-301a of DoD 5220.22-M, “National Industrial Security 
Program Operating Manual (NISPOM)”, clearing is the process of eradicating the 
data on media before reusing the media so that the data can no longer be retrieved 
using the standard interfaces on the instrument. Clearing is typically used when the 
instrument is to remain in an environment with an acceptable level of protection.

Instrument 
Declassification

A term that refers to procedures that must be undertaken before an instrument can 
be removed from a secure environment, such as is the case when the instrument is 
returned for calibration. Declassification procedures include memory sanitization or 
memory removal, or both. Agilent declassification procedures are designed to meet 
the requirements specified in DoD 5220.22-M, “National Industrial Security Program 
Operating Manual (NISPOM)”, Chapter 8.

Sanitization As defined in Section 8-301b of DoD 5220.22-M, “National Industrial Security 
Program Operating Manual (NISPOM)”, sanitization is the process of removing or 
eradicating stored data so that the data cannot be recovered using any known 
technology. Instrument sanitization is typically required when an instrument is moved 
from a secure to a non-secure environment, such as when it is returned to the factory 
for calibration.
Agilent memory sanitization procedures are designed for customers who need to 
meet the requirements specified by the US Defense Security Service (DSS). These 
requirements are specified in the “Clearing and Sanitization Matrix” in Appendix O of 
the ODAA Process Guide for C&A of Classified Systems under NISPOM.

Secure Erase Secure Erase is a term that is used to refer to either the clearing or sanitization 
features of Agilent instruments.
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5 Instrument Memory & 
Certificate of Volatility

This chapter summarizes all memory types in the instrument, for the following processor assembly and disk 
drive configurations:

a. Single-Core, Fixed Disk processor assemblies,

b. Single-Core, Removable Disk and Dual-Core, Removable Disk processor assemblies.
For definition of terms, and to determine the configuration of your instrument, based on its Product Name and 
installed options, see “X-Series Processor and Disk Drive Configurations” on page 10.

The descriptions below are divided between:

1. Non-Volatile Memory,

2. Volatile Memory.
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Non-Volatile Memory
This section contains information on the memory components available in your instrument. 

Table 5-1 on page 20 describes memory components that are present in all instruments. 

Table 5-2 on page 25 describes additional memory components that are present only in PXA instruments. 

Both tables provide details of the size of each memory component, its type, how it is used, its location, 
volatility, and the sanitization procedure.

NOTE The instrument contains no user-accessible non-volatile memory, except for the Disk 
Drive described in Item 1 of Table 5-1 on page 20. For this reason, as indicated in the 
tables below, no sanitization procedure is required for any memory component except 
the Disk Drive.

Table 5-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and 
Dual-Core Processors)
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Location in 
Instrument 
and Remarks

Sanitization 
Procedure

1. Disk Drive
Fixed 
Magnetic: 
40 GByte
Removable 
Magnetic: 
160 GByte
Removable 
Solid-State 
Original: 
32 GByte
New: 80 GByte
This drive is 
partitioned, as 
detailed in 
“Disk Drive 
Partitioning” 
on page 26.

Yes Yes Contains Operating 
System, Instrument 
Software, Factory 
Calibration Data, 
Diagnostic software, 
Crash recovery image, 
user instrument 
states, user data files, 
user trace data and 
any user installed 
third party software.

Programmed 
before 
installation or by 
factory/service 
center 
calibration 
procedure 
software, or by 
upgrade 
installation 
software. Also 
programmed via 
operations and 
by the user.

Single-Core, 
Fixed Disk: A4 
Processor 
Assy.
Single-Core, 
Removable 
Disk and 
Dual-Core, 
Removable 
Disk: Rear 
Panel 
(Removable)
Contains user 
data.

See Table 
6-1 on 
page 29.
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2. CPU BIOS 
(CMOS 
NVRAM)
256 Byte
(battery 
backed)

No Yes Contains default BIOS 
settings to use when 
booting the Processor 
Assembly.

Programmed by 
factory. Settings 
can be toggled 
by user.

A4 Processor 
Assy.
Battery 
backed to 
maintain 
Windows 
calendar time.
Contains no 
user data.

None.

3. License 
Storage 
Memory
(EEPROM)
512 kbit

No Yes Contains instrument 
serial number and 
license keys for 
measurement 
applications. License 
keys are encrypted. 

Programmed 
before 
installation and 
by installing 
new license 
keys.

A7 Midplane 
Assy.
Contains no 
user data.

None.

4. Config & Cal 
Memory 
(EEPROM)
8 kbit
(1024 x 8)

No Yes Header EEPROM 
used to identify the 
assembly.

Programmed 
before 
installation.

A14 
Synthesizer 
Assy.
Contains no 
user data.

None.

5. Config 
Memory 
(EEPROM)
8 kbit
(1024 x 8)

No Yes Contains 
measurement and 
control software, 
which is preloaded 
into FPGA during 
instrument power-up.

Programmed 
before 
installation.

A14 
Synthesizer 
Assy.
Contains no 
user data.

None.

6. Config & Cal 
Memory 
(EEPROM)
8 kbit
(1024 x 8)

No Yes Header EEPROM 
used to identify the 
assembly.

Programmed 
before 
installation.

A15 Front End 
Control Assy.
Contains no 
user data.

None.

Table 5-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and 
Dual-Core Processors)
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7. Config 
Memory 
(Flash)
2 Mbit

No Yes Contains 
measurement and 
control software, 
which is preloaded 
into FPGA during 
instrument power-up. 
Primarily YTF, 
attenuator, and front 
end switch control.

Programmed 
before 
installation.

A15 Front End 
Control Assy.
Contains no 
user data.

None.

8. Config & Cal 
Memory 
(EEPROM)
8 kbit
(1024 x 8)

No Yes Header EEPROM 
used to identify the 
assembly.

Programmed 
before 
installation.

A2 Analog IF 
Assy.
Contains no 
user data.

None.

9. Control 
Logic Memory
(CPLD)
1600 Gates

No Yes Contains control 
algorithms to 
optimize filter 
performance.

Programmed 
before 
installation.

A2 Analog IF 
Assy.
Contains no 
user data.

None.

10. Config & 
Cal Memory 
(EEPROM)
8 kbit
(1024 x 8)

No Yes Header EEPROM 
used to identify the 
assembly.

Programmed 
before 
installation.

A3 Digital IF 
Assy.
Contains no 
user data.

None.

11. Config 
Memory 
(Flash)
8 Mbit

No Yes Contains 
measurement and 
control software, 
which is preloaded 
into FPGA during 
instrument power-up.

Programmed 
before 
installation.

A3 Digital IF 
Assy.
Contains no 
user data.

None.

Table 5-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and 
Dual-Core Processors)
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12. Control 
Logic Memory 
(CPLD)
6400 Gates

No Yes Contains 
measurement and 
control algorithms to 
optimize digital 
filtering.

Programmed 
before 
installation.

A3 Digital IF 
Assy.
Contains no 
user data.

None.

13. Serial 
Presence 
Detect 
Memory
(EEPROM)
2 Mbit

No Yes Used on commercial 
SDRAM Module, 
programmed by chip 
vendor. Contains 
module identification 
information. 

Programmed by 
IC vendor only.

A3 Digital IF 
Assy.
Contains no 
user data.

None.

14. Config & 
Cal Memory 
(EEPROM)
8 kbit
(1024 x 8)

No Yes Header EEPROM 
used to identify the 
assembly.

Programmed 
before 
installation.

A16 
Reference 
Assy.
Contains no 
user data.

None.

15. FPGA 
Config Memory
(EEPROM)
2 Mbit

No Yes Contains 
measurement and 
control software.

Programmed 
before 
installation.

A16 
Reference 
Assy.
Contains no 
user data.

None.

16. Digital 
Potentiometer
 (EEPROM)
112 bits
(14 Bytes) 

No Yes Contains default data 
to preset digital 
potentiometers 
during power-up. 

Programmed 
before 
installation.

A16 
Reference 
Assy.
Contains no 
user data.

None.

Table 5-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and 
Dual-Core Processors)
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17. Front Panel 
EEPROM
64 kbit

No Yes Contains software for 
running front panel 
microcontroller. 
Operates front panel 
LEDs, and transmits 
key presses to 
processor.

Programmed 
before 
installation.

A1A2 Front 
Panel 
Interface 
Board
Contains no 
user data.

None.

18. Front Panel 
CPLD
800 Gates

No Yes Contains fixed digital 
logic associated with 
front panel keyboard 
button operation and 
LEDs.

Programmed 
before 
installation at 
the factory only.

A1A2 Front 
Panel 
Interface 
Board
Contains no 
user data.

None.

19. EDID 
Memory
(EEPROM)
2 kbit

No Yes Extended Display 
Identification Data is 
a VESA standard data 
format that contains 
basic information 
about a monitor and 
its capabilities, 
including vendor 
information, 
maximum image size, 
color characteristics, 
factory pre-set 
timings, frequency 
range limits, and 
character strings for 
the monitor name and 
serial number.

Programmed 
before 
installation.

A1A2 Front 
Panel 
Interface 
Board.
Contains no 
user data.

None.

Table 5-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and 
Dual-Core Processors)
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Table 5-2 Summary of Non-Volatile instrument memory - Additional Components for PXA 
Instruments Only (Dual-Core Processor)
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1. Boot ROM
(Flash)
8 MByte

No Yes Contains the boot 
ROM, operating 
system and run-time 
code for the WBDIF 
CPU.

Programmed by 
factory at 
installation time, 
or during 
firmware 
upgrade.

A26 WBDIF 
assembly
Contains no 
user data.

None.

2. (Flash) 
16 MByte
(2 x 64 Mbit)

No Yes Contains up to 3 
WBDIF FPGA images.

Programmed by 
factory at 
installation time, 
or during FPGA 
upgrade 
process.

A26 WBDIF 
assembly
Contains no 
user data.

None.

3. (EEPROM) 
512 Byte

No Yes Contains header 
information used to 
identify the assembly, 
and configuration 
information used to 
initialize the PCI bus.

Programmed 
before 
installation.

A26 WBDIF 
assembly
Contains no 
user data.

None.

4. (EEPROM)
1024 byte 

No Yes Contains 
configuration 
information used 
during initialization of 
the PCI bus. 
This component is 
currently 
unprogrammed.

Programmed 
before 
installation.

A26 WBDIF 
assembly
Contains no 
user data.

None.

5. (CPLD)
256 
Macrocells

No Yes Contains critical 
hardware control 
algorithms.

Programmed 
before 
installation.

A26 WBDIF 
assembly
Contains no 
user data.

None.
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Disk Drive Partitioning
The instrument’s disk drive is divided at the factory into three visible partitions, labeled C:, D: and E:, plus a 
fourth hidden partition. 

The sizes of each partition vary according to the instrument’s Disk Drive Configuration.

Details of the sizes and functions of all partitions are provided in Table 5-3 below.

Table 5-3 Disk Drive Partitions

Partition 
Label

Size (GBytes) Purpose

C: Fixed Magnetic: 15 GB
Removable Magnetic: 62 GB
Removable Solid-State:
(Original) 16 GB
(New) 32 GB

Primary partition for applications and secondary 
data.

D: Fixed Magnetic: 6 GB
Removable Magnetic: 23 GB
Removable Solid-State:
(Original) 3.75 GB
(New) 17 GB

Default location for user data.

E: Fixed Magnetic: 6 GB
Removable Magnetic: 2.3 GB
Removable Solid-State:
(Original) 1.6 GB
(New) 2 GB

Calibration data.

Hidden Fixed Magnetic: 6.5 GB
Removable Magnetic: 54 GB
Removable Solid-State:
(Original) 8.2 GB
(New) 23 GB

Factory recovery image of the C: partition.
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Volatile Memory
The volatile memory in the instrument does not have battery backup. It does not retain any information when 
AC power is removed. 

Removing power from this memory meets the memory sanitization requirements specified in the “Clearing 
and Sanitization Matrix” in Appendix O of the ODAA Process Guide for C&A of Classified Systems under 
NISPOM.

Table 5-4 Summary of Volatile Instrument Memory - Instruments with Single-Core and Dual-Core 
Processors
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1. Processor 
SDRAM
Single-Core, 
Fixed Disk: 
1 GByte or 
2 GByte
Single-Core, 
Removable 
Disk or 
Dual-Core, 
Removable 
Disk: 4 GByte

Yes No Main dynamic RAM 
memory for 
processor. 
Contains working 
copies of Operating 
System, instrument 
measurement 
applications, 
calibration data, and 
measurement data.

Programmed 
before 
installation, or by 
factory/service 
center calibration 
procedure 
software, or by 
firmware upgrade 
installation 
software.
Also programmed 
via firmware 
operations and by 
user.

A4 Processor 
Assy.
Contains user 
data.
This memory 
is not battery 
backed-up or 
connected to 
standby 
power.

Turn off 
instrument 
power.

2. SDRAM
256 MByte

Yes No Contains 
measurement data 
from data 
acquisition system.

Programmed by 
firmware. Not 
accessible by 
user.

A3 Digital IF 
Assy.
Contains raw 
measurement 
data.
This memory 
is not battery 
backed-up or 
connected to 
standby 
power.

Turn off 
instrument 
power.
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6 Memory Clearing, 
Sanitization and/or Removal 
Procedures

This section explains how to clear, sanitize, and remove memory from your instrument, for all types of 
non-volatile memory that can be written to during normal instrument operation.

Table 6-1 Disk Drive

Description and 
purpose

The Disk Drive is the main memory for the instrument. It has very large storage 
capacity, plus fast read and write times. There are no limitations on the number of 
read/write cycles.
It contains the Operating System, Instrument Software, Factory Calibration Data, 
Diagnostic software, Crash recovery image, user instrument states, user data files, 
user trace data and any user-installed third party software. The Disk Drive is 
written to frequently by the Operating System and other application software.

Size Fixed Magnetic magnetic disk drive: 40 Gigabytes
Removable Magnetic disk drive: 160 Gigabytes
Removable Solid-State disk drive: 32 Gigabytes (original) or 80 Gigabytes (new)

Memory clearing Software utilities are available that comply with the clearing requirements 
specified for Magnetic Disks in the “Clearing and Sanitization Matrix” in 
Appendix O of the ODAA Process Guide for C&A of Classified Systems under 
NISPOM.

Memory sanitization We recommend always removing the Disk Drive to achieve sanitization. 
For program classifications lower than Top Secret, this media type can be 
sanitized using method "d" as defined in the "Clearing and Sanitization Matrix" in 
Appendix O of the ODAA Process Guide for C&A of Classified Systems under 
NISPOM“. 
For Top Secret and higher program classifications, Disk Drive removal is the only 
acceptable sanitization procedure. 
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Memory removal Single-Core, Fixed Disk Processor assembly: see “Instruments with 
Non-Removable Drives” on page 46, in the Chapter "Disk Drive Removal 
Procedure".
Single-Core, Removable Disk or Dual-Core, Removable Disk Processor assemblies: 
see “Instruments with Removable Drives” on page 47, in the Chapter "Disk Drive 
Removal Procedure".

Write protecting The Disk Drive cannot be write protected. The operating system and software 
must be able to read from and write to the drive during normal operation.

Memory validation The Disk Drive memory can be validated using third-party Windows utilities.

Table 6-2 CPLD, CMOS Programmable Logic Devices

Description and 
purpose

These memory devices are used to execute timing, control, and measurement 
functions. No user data is contained in these devices. This memory cannot be 
written to during instrument operation.

Size 1600 to 6400 logic gates.

Memory clearing Not applicable. This memory does not contain user information and is not 
accessible by the user.

Memory sanitization Not applicable. This memory does not contain user information and is not 
accessible by the user.

Memory removal Not applicable. 

Write protecting Not applicable. 

Memory validation Not applicable. 

Remarks These devices are programmed in the factory via diagnostic connectors on the 
PCB assemblies. After instrument assembly, the diagnostic connectors are not 
physically accessible and not electrically connected. 

Table 6-3 EEPROM Memories

Description and 
purpose

These memories are used to identify the assemblies (header info) and store option 
configuration data. Some are also used to hold factory software for FPGAs. The 
software is loaded when the instrument powers up. This memory cannot be 
written to during instrument operation.

Size 2 Kbit to 8 Mbit

Memory clearing Not applicable. This memory does not contain user information and is not 
accessible by the user.

Memory sanitization Not applicable. This memory does not contain user information and is not 
accessible by the user.

Memory removal Not applicable. 

Table 6-1 Disk Drive
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Write protecting Not applicable. 

Memory validation Not applicable. 

Remarks With one exception, as described below, these memories are only writable by 
factory/service center software, or upgrade installation software. These 
memories are internally connected to proprietary internal control data busses (as 
opposed to standard computer busses such as IDE, PCI, USB). They are not 
accessible by the Operating System or by third-party software, or by the user, to 
protect the measurement accuracy and consistency of the instrument. They are 
rarely modified, to ensure no degradation of instrument performance. These 
memories contain no user data. Many of these memories have long write times, 
and limited write endurance, so they are not intended to be written to dynamically 
by software.
The sole exception applies to the EEPROM on the A7 Midplane Assembly. 
Inserting a USB memory device containing a valid license key file into the 
instrument causes the key file to be copied to both the C: drive and the EEPROM 
on the A7 Midplane Assembly. 

Table 6-3 EEPROM Memories
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Instrument Sanitization Procedures
This section includes flowcharts that describe how to sanitize an instrument by physical removal and 
replacement of either the Processor Assembly or Disk Drive.

• For Single-Core, Fixed Disk instruments, see “Replacement of Processor Assembly” on page 32.

• For Single-Core, Removable Disk and Dual-Core, Removable Disk instruments, see “Replacement of Disk 
Drive” on page 34.

Application License Key Storage
Note that License keys for most Applications are stored in EEPROM on the A7 Midplane Assembly (as 
described in Item 3 of Table 5-1 on page 20). Therefore, when replacing either the Processor Assembly or 
Disk Drive, you do not need to back up and restore the license keys.

The sole exception is the 89601A VSA Application, which uses a Site Key license. For information on how to 
regenerate a Site Key, see Regenerating a Site Key License for 89601A VSA Application below.

Regenerating a Site Key License for 89601A VSA Application
When replacing a Processor Assembly or Disk Drive for an instrument that includes the 89601A VSA 
Application, you must request a new Site Key License, as if installing 89601A VSA for the first time. Details of 
how to do this are provided in the following article, available on the Agilent web site:

How do I recover my VSA 89600S license after a hard drive crash?

NOTE This requirement applies only to the 89601A VSA Application. It does not apply to the 
newer 89601B.

Replacement of Processor Assembly
This procedure applies only to Single-Core, Fixed Disk instruments.

Refer to the flowchart in Figure 6-1 for details of how to perform this procedure. 

Note that this flowchart differs from that for replacement of the Disk Drive only in that the entire Processor 
Assembly is replaced. The steps that differ between the two procedures are marked in yellow in the 
flowcharts.

For details of how to archive or restore the instrument’s calibration files (Steps 2, 11 and 15 in the flowchart), 
see “Archiving and Restoring Factory Calibration Data Files” on page 36.

For details of how to remove the Processor Assembly (Step 5), see “Processor Assembly Removal 
Procedure” on page 43.

www.agilent.com/find/recoverVSAlicense
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Figure 6-1 Flowchart for Instrument Sanitization Process by Processor Removal
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Replacement of Disk Drive
This procedure applies to Single-Core, Removable Disk and Dual-Core, Removable Disk instruments.

Refer to the flowchart in Figure 6-2 for details of how to perform this procedure. 

Note that this flowchart differs from that for replacement of the Processor Assembly only in that the 
removable Disk Drive is replaced. The steps that differ between the two procedures are marked in yellow in 
the flowcharts.

For details of how to archive or restore the instrument’s calibration files (Steps 2, 11 and 15 in the flowchart), 
see “Archiving and Restoring Factory Calibration Data Files” on page 36.

For details of how to remove the Disk Drive (Step 5), see “Disk Drive Removal Procedure” on page 45.

IMPORTANT When installing a replacement Disk Drive, ensure that the instrument software 
revision on the replacement drive matches that of the original drive.
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Figure 6-2 Flowchart for Instrument Sanitization Process by Disk Drive Removal



36 

Memory Clearing, Sanitization and/or Removal Procedures
Archiving and Restoring Factory Calibration Data Files

Archiving and Restoring Factory Calibration Data Files
This section describes how to archive ("back up") the instrument’s factory calibration data to an external 
USB memory device, or restore the calibration data from an external memory device.

The backup and restore procedures differ according to the instrument software revision. This section 
describes the three possible pairs of procedures.

To determine the instrument software revision, follow the procedure “Determining Instrument Software 
Revision” on page 37 below.

To determine which backup or restore procedures should be used, according to the instrument software 
revision, see Table 6-4 on page 38.

Tools Required
To perform backup or restore operations, you need:

• a mouse with a USB interface

• a portable memory device with a USB interface

• an alphanumeric keyboard with a USB interface
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Determining Instrument Software Revision
1. On the instrument front panel, press System > Show > System.

2. The "Show System" display appears, as shown in Figure 6-3 below. Look for the Software Revision 
number specified in the "Instrument S/W Revision" entry.

Figure 6-3 Show System Display

3. To dismiss the "Show System" display, press any other front-panel or menu key.
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When you have obtained the instrument Software Revision number, refer to Table 6-4 on page 38 below for 
the appropriate backup or restore procedure.

Software Revision A.01.55 or Lower
If the instrument software revision is A.01.55 or lower, the calibration data is stored in an XML database file. 

Data Backup using XML File
Follow the steps below:

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB memory device into another of the instrument’s USB ports.

4. Using the mouse, double-click on the Windows Explorer icon on the desktop and navigate to the following 
folder: 

E:\AlignDataStorage

5. Copy the following file onto the USB memory device: 

CurrentDataSet.xml

Data Restore using XML File
The data can be restored from a USB memory device containing the XML database file, by using the following 
process.

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB memory device into another of the instrument’s USB ports.

4. Using the mouse, double-click on the Windows Explorer icon on the desktop and navigate to a folder on 
the USB memory device containing a previously-saved calibration data file named:

CurrentDataSet.xml

Table 6-4 Backup & Restore Procedures for all Instrument Software Revisions

Instrument Software 
Revision

Backup Procedure Restore Procedure

A.01.55 or lower See “Data Backup using XML File” 
on page 38.

See “Data Restore using XML File” on 
page 38.

Greater than A.01.55; 
lower than A.02.00

See “Data Backup using Utility 
Program” on page 39.

See “Data Restore using Utility Program” 
on page 40.

A.02.00 or greater See “Data Backup or Restore using 
Alignment Data Wizard” on page 40.

See “Data Backup or Restore using 
Alignment Data Wizard” on page 40.
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5. Select the calibration data file, then copy it to the Windows clipboard by selecting Edit > Copy from the 
Windows Explorer pull-down menu.

6. Navigate to the folder below and paste the file by selecting Edit > Paste from the Windows Explorer 
pull-down menu: 

E:\AlignDataStorage

7. Verify that the file CurrentDataSet.xml was copied to the new location.

8. Cycle the instrument power.

Software Revision Greater than A.01.55 and Lower than A.02.00
If the instrument software revision is greater than A.01.55, the calibration data is stored in an SQL database 
file. 

For software revisions greater than A.01.55, but lower than A.02.00, the SQL file is written and read by a 
utility program called BackupAndRestore.exe.

Data Backup using Utility Program
Follow the steps below:

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB memory device into another of the instrument’s USB ports.

4. Plug the USB keyboard into another of the instrument’s USB ports.

5. Using the mouse double-click on the Windows Explorer icon on the desktop and navigate to the following 
folder: 

C:\Program Files\Agilent\SignalAnalysis\Physics

6. Double-click on BackupAndRestore.exe. The "Calibration Data Backup And Restore" dialog shown 
in Figure 6-4 appears.

Figure 6-4 Calibration Data Backup

7. In the group box “Specify Backup Folder or File Name” use the mouse to press the “...” button to open 
the “Browse For Folder” dialog.
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8. In the "Browse For Folder" dialog, select or create the desired folder on the USB memory device, then 
press OK.

9. Press Backup, then wait for the calibration database to be backed up.

10. When the backup has completed, close the "Calibration Data Backup And Restore" dialog.

Data Restore using Utility Program
Follow the steps below:

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB memory device into another of the instrument’s USB ports.

4. Using the mouse double-click on the Windows Explorer icon on the desktop and navigate to the following 
folder: 

C:\Program Files\Agilent\SignalAnalysis\Physics

5. Double-click on BackupAndRestore.exe: the "Calibration Data Backup And Restore" dialog shown in 
Figure 6-4 appears.

Figure 6-5 Calibration Data Backup

6. In the group box “Specify File To Restore From” use the mouse to press the “...” button to open the 
“Browse For File” dialog.

7. In the "Browse For File" dialog, select the desired file on the USB memory device, then press OK.

8. Press Restore, then wait for the calibration database to be restored.

9. When the restore has completed, close the "Calibration Data Backup And Restore" dialog.

Software Revision A.02.00 or Greater
For software revisions A.02.00 or greater, the SQL calibration data file is read and written by the Alignment 
Data Wizard.

Data Backup or Restore using Alignment Data Wizard
The Alignment Data Wizard is launched directly from the instrument application software interface, so you do 
not need to exit the application software before proceeding. 

Follow the steps below to start the wizard:



41

Memory Clearing, Sanitization and/or Removal Procedures
Archiving and Restoring Factory Calibration Data Files

1. Plug the mouse’s USB cable into one of the instrument’s USB ports.

2. Plug the USB memory device into another of the instrument’s USB ports.

3. Plug the USB keyboard into another of the instrument’s USB ports.

4. Press System > Alignments > Backup or Restore Align Data...

5. The Alignment Data Wizard dialog appears, as shown in Figure 6-6 below:

Figure 6-6 Alignment Data Wizard Dialog

6. Follow the wizard’s on-screen instructions to back up the calibration data to the external USB memory 
device, or restore the data from the device.
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7 Processor Assembly Removal 
Procedure

To remove the processor board assembly, follow the procedure below, while referring to Figure 7-1, which 
shows the rear panel of instruments with Single-Core, Fixed Disk processor assemblies. 

The procedure for instruments with Single-Core, Removable Disk or Dual-Core, Removable Disk processor 
assemblies is identical, although the appearance of the rear panel differs from that shown in Figure 7-1. (For 
comparative illustrations of the rear panel types, see “Rear Panel Configurations” on page 14.)

CAUTION Before removing the Processor Assembly, ensure that the instrument’s power is 
turned off.
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Figure 7-1 Processor Assembly Removal Procedure

1. Locate and remove the Processor Assembly from the instrument, by removing the 6 rear panel screws 
(part number 0515-0372, M3 x 0.5, 8 mm long). 

2. The assembly can be removed from the chassis by pulling it straight out. Use the two ejector arms to 
remove the Assembly from the instrument

TIP Most Application License keys are stored in EEPROM on the A7 Midplane Assembly 
(as described in Item 3 of Table 5-1 on page 20). Therefore, when replacing the 
Processor Assembly, you do not need to back up and restore the license keys.

The sole exception is the license key for the 89601A VSA Application. For information 
about how to regenerate these licenses, see “Regenerating a Site Key License for 
89601A VSA Application” on page 32.
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8 Disk Drive Removal 
Procedure

This chapter describes the procedures for physical removal of the disk drive from:

a. Instruments with Non-Removable Drives (generally, older MXA, EXA and CXA instruments),

b. Instruments with Removable Drives (generally, all PXA instruments, and newer MXA, EXA and CXA 
instruments).

For detailed information about the drive types installed in each instrument type, see the section “X-Series 
Processor and Disk Drive Configurations” on page 10, in the Chapter Products Covered by this Document.

TIP Most Application License keys are stored in EEPROM on the A7 Midplane Assembly 
(as described in Item 3 of Table 5-1 on page 20). Therefore, when replacing the Disk 
Drive, you do not need to back up and restore the license keys.

The sole exception is the license key for the 89601A VSA Application. For information 
about how to regenerate these licenses, see “Regenerating a Site Key License for 
89601A VSA Application” on page 32.

When installing a replacement Disk Drive, ensure that the instrument software 
revision on the replacement drive matches that of the original drive.
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Instruments with Non-Removable Drives
To remove the disk drive, follow the procedure below, while referring to Figure 8-1. The numbered items in the 
figure correspond to the step numbers in the procedure.

Before commencing this procedure, remove the complete Processor Assembly from the instrument, following 
the procedure described in the chapter Processor Assembly Removal Procedure.

Figure 8-1 Disk Drive Removal Procedure

1. Remove 15 screws from the top lid of the Processor Assembly.

2. Tilt the lid up.

3. While holding the disk drive to prevent it from falling, remove the 4 drive retaining screws.

4. Disconnect the drive cable from the disk drive. 
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Instruments with Removable Drives
To remove the disk drive, follow the procedure below. You do not need to remove the Processor Assembly 
from the instrument before removing the drive.

The numbered items in the figures below correspond to the step numbers in the procedure.

CAUTION Before removing the disk drive, ensure that the instrument’s power is turned off.

1. Locate the Processor and Disk Drive Assembly on the instrument’s rear panel, as shown in Figure 3-2 in 
the section “Rear Panel Configurations” on page 14. In Figure 8-2 below, the processor assembly is 
shown removed from the rear panel for clarity.

Figure 8-2 Processor Assembly with Removable Disk Drive

2. Locate the removable drive, and its retaining thumbscrew, as shown in Figure 8-2.

3. Turn the thumbscrew to release the drive from the panel, as shown in Figure 8-3 below. If the thumbscrew 
is too tight to turn by hand, use a TORX T10 screwdriver to loosen it.
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Figure 8-3 Removable Disk Drive Unit partially extracted

4. Pull the U-shaped handle attached to the drive unit, to remove the drive from the Processor Assembly, as 
shown in Figure 8-3.



49

User and Remote Interface Security Measures
SCPI/GPIB Control of Interfaces

9 User and Remote Interface 
Security Measures

This chapter discusses options that are available to you to control and configure remote access to the 
instrument, including:

• SCPI/GPIB Control of Interfaces

• Operating System Security Features

• USB Interfaces. This topic includes information about how to set the instrument’s USB ports to read-only.

IMPORTANT Users are responsible for providing security for the I/O ports for remote access, by 
controlling physical access to the I/O ports. The I/O ports must be controlled because 
they provide access to most user settings, user states, and the display memory.

SCPI/GPIB Control of Interfaces
The GPIB command LLO (local lockout) can be sent by the controller to disable operation of the instrument’s 
front-panel keys and softkey menus.

However, sending the LLO command does not disable access to the instrument via its USB ports. For details 
of how to restrict the operation of the USB ports, see “Configuring USB for Read-only” on page 53 below.

Operating System Security Features
The instrument’s Windows operating system includes a variety of features that you can invoke or modify to 
enhance system security. These include the following:

• The ability to create custom user accounts, and assign different security levels to each account by adding 
it to an existing group. The group types predefined by Windows are: Administrator, Power User, User, 
Backup Operator, and Guest, but you can also define new group types.

• To provide additional protection for instruments that have a network (or internet) connection, the standard 
Windows Firewall is enabled by default.
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• You can install standard third-party antivirus and spyware detection software designed for use with 
Windows XP. If your instrument uses a network (or internet) connection, this may be advisable.

CAUTION Running any third-party program while making measurements may adversely affect the 
instrument’s performance.

Details of all these features are provided in the "Windows Security" chapter of the Agilent X-Series Signal 
Analyzer: Getting Started Guide.

USB Interfaces
The instrument’s Microsoft Windows operating system can be configured to improve the security of the USB 
interfaces.

Disabling or Enabling Autorun/Autoplay
Autorun, and the associated Autoplay, are Windows features that assist users in selecting appropriate 
actions when new media and devices are detected. The Autorun feature is disabled in the instrument by 
default, for improved security, unless the Administrator account is running. (In Administrator mode, Autorun 
is enabled, to aid with program installation.)

You can change the Autorun configuration by editing the value of one of two Windows Registry keys. The 
Windows Registry is a database that stores critical configuration information for the instrument’s operating 
system.

CAUTION Exercise extreme caution whenever you edit the Windows Registry. Entering an 
incorrect Registry value, or accidentally deleting Registry keys, may have serious 
consequences that can prevent the system from starting, or require that you reinstall 
Windows. The instructions in “Disable & Enable Procedure” on page 51 below assume 
that you are familiar with the use of the Windows Registry Editor to modify Registry 
settings.

Registry Key Definitions
Autorun can be configured per-machine or per-user.

NOTE If the per-machine Registry key is present, its settings override those of the per-user 
Registry key.

The Registry key that controls the per-machine Autorun settings is:

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Policies\Explor
er\NoDriveTypeAutoRun
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The Registry key that controls the per-user Autorun settings is:

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\policies\Explore
r\NoDriveTypeAutoRun

In the following discussions, we use the industry-standard abbreviation HKLM for the root key 
HKEY_LOCAL_MACHINE, and the industry-standard abbreviation HKCU for the root key 
HKEY_CURRENT_USER.

The DWORD value of either of these entries represents a set of single-bit flags. Each flag specifies the 
Autorun setting for a specific drive type, as shown in Figure 9-1 on page 51. Setting a bit flag to 1 disables 
Autorun for that drive type.

Figure 9-1 Autorun Flag Definitions for NoDriveTypeAutoRun Registry entry

As shown in Figure 9-1 on page 51 above, the default Windows XP (post-SP2) value for this entry is 0x91 
(under the entry HKCU\...\NoDriveTypeAutoRun). This setting disables Autorun for Unknown and 
Network drives, but enables Autorun for Removable, Fixed, CD/DVD or RAM drives.

You can disable Autorun for all drive types by changing the value to 0xFF, as described in the following 
section.

Disable & Enable Procedure
In view of the interaction between the per-machine and per-user Registry settings, as described above, it is 
recommended that, if both keys exist in your instrument’s Registry, you should alter the settings of both 
Registry keys to the same value at the same time. 
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Use the following procedure to disable Autorun for all drive types, or to revert all Autorun settings to their 
Windows XP default values.

1. Open the Windows Registry editor. Generally, the easiest way to do this is to select Run... from the 
Windows Start menu. Then, type regedit into the Windows Run dialog box, as shown in Figure 9-2 
below, and click OK.

Figure 9-2 Windows Run Dialog

2. The Registry Editor window appears. Using the tree view control on the left of the window, navigate to the 
per-machine (HKLM) key: 
HKLM\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer.

3. To disable Autorun for all drive types, set the value of entry NoDriveTypeAutoRun to 0xFF.

To revert Autorun settings to the Windows default values, set the value of entry 
NoDriveTypeAutoRun to 0x91.

4. Again using the tree view control on the left of the Registry Editor window, navigate to the per-user 
(HKCU) key: HKCU\SOFTWARE\Microsoft\Windows\CurrentVersion\policies\Explorer.

5. To disable Autorun for all drive types, set the value of entry NoDriveTypeAutoRun to 0xFF.

To revert Autorun settings to the Windows default values, set the value of entry 
NoDriveTypeAutoRun to 0x91.

6. From the Registry Editor menu, select File > Exit to save the settings and exit the editor.

7. Shut down and restart the instrument, to enable the new settings to take effect.

Microsoft AutoRun Patch
There is a defect in Windows XP that compromises the ability to disable Autorun. This defect has been fixed 
by a patch from Microsoft, as described in the Microsoft Knowledge Base Article ID: 967715.

This patch has been included in new instrument shipments from the factory since revision A.03.00.

After the patch has been applied, there will be a Registry entry at:

HKLM\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer\HonorAutoru
nSetting with a default value of 1.
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More Information
The following Wikipedia articles provide more information about AutoRun and AutoPlay:

http://en.wikipedia.org/wiki/AutoRun

http://en.wikipedia.org/wiki/AutoPlay

Configuring USB for Read-only
As from instrument software revision A.04.00, a convenient mechanism is provided to set the instrument’s 
USB interfaces to read-only, thus preventing transfer of files from the instrument onto USB devices.

You can change this setting only when you are logged on as the Administrator. For details of how to log on to 
the instrument as the Administrator, see the Agilent X-Series Signal Analyzer: Getting Started Guide. To 
change the setting, do the following:

1. If you are not currently logged on to the instrument as the Administrator, you must log out. 

If you are currently logged on to the instrument as the Administrator, and the Agilent XSA application is 
already running, go to Step 4.

The log-off procedure executes more quickly if you first exit the Agilent XSA application, but you can also 
log off without exiting the application.

2. Select Log Off from the Windows Start menu (as highlighted in Figure 9-3 below), then click Log Off in the 
Log Off Windows dialog that appears.

Figure 9-3 Log Off Button in Windows Start Menu

3. After you have logged on to the instrument as the Administrator, restart the Agilent XSA application. 

4. When the XSA application has fully initialized (that is, when the main results view and softkey menu are 
visible), press the System front-panel key.

5. From the System softkey menu, select: More > Security > USB.

6. Select the option Read Only.

7. To activate the configuration change, either log out and then back in under your usual user name (which 
by default is "instrument"), or cycle the instrument power.

http://en.wikipedia.org/wiki/AutoRun
http://en.wikipedia.org/wiki/AutoPlay
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10 Procedure for Declassifying a 
Faulty Instrument

Even if the instrument is not able to power on, it may be declassified by removing the disk drive from the 
instrument, using the appropriate procedure as described in “Disk Drive Removal Procedure” on page 45.
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1. DoD 5220.22-M, “National Industrial Security Program Operating Manual (NISPOM)”
United States Department of Defense. Revised February 28, 2006.
May be downloaded in Acrobat (PDF) format from:
http://www.dss.mil/isp/fac_clear/download_nispom.html

2. ODAA Process Guide for C&A of Classified Systems under NISPOM
Defense Security Service.
DSS-cleared industries may request a copy of this document via email, by following the 
instructions at: 
http://www.dss.mil/isp/odaa/request.html

3. Agilent X-Series Signal Analyzer: Getting Started Guide
Agilent Technologies Inc. 2008-2011. Part Number: subject to change as document is revised.
A printed copy of this document is supplied with each Agilent X-Series Analyzer. 
It is also available in Acrobat (PDF) form: 

• on the Documentation DVD supplied with each instrument,
• on the instrument’s disk drive at the following location:

C:\Program Files\Agilent\SignalAnalysis\Infrastructure\Help\bookfiles\getstart.pdf
• via download from:

www.agilent.com/find/xseries_getting_started_guide

4. Microsoft Knowledge Base Article ID: 967715
"How to disable the Autorun functionality in Windows": may be viewed at:
http://support.microsoft.com/kb/967715
Note that a second article, at: http://support.microsoft.com/kb/953252, "How to correct 
’disable Autorun registry key’ enforcement in Windows", redirects to article ID 967715.

http://www.dss.mil/isp/fac_clear/download_nispom.html
http://www.dss.mil/isp/odaa/request.html
http://support.microsoft.com/kb/967715
http://support.microsoft.com/kb/953252
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